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Introducing ID Flow 4
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ID Flow is premier software for ID card design, production and data management.

This guide provides basic understanding of product components and how to get started.
This guide is a supplement to the Help Menu provided within the product. The built-in
Help Menu provides comprehensive configuration details for each dialog.

There are two primary ID Flow interfaces:

Card Designer

l;_-|0|:|//—’4? oS

m <<First>> <<Last>>
- <<Title>>

El08

2

ID #<<|DNumber>>

<<Photo>>

W ERY A I

Card Issue Center

Cardholder Group: )

Enmll

Loskup

& Repart Center |

Acme Technologies

™ LisaJohnson

Director of Marketng

Use the Card Designer to create your card designs and point them to the appropriate
data source. Once the designs are completed and saved, import the designs into the
Card Issue Center for production and data management.
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The Quick Start Option

ID Flow Card Issue Center is pre-configured with two sample Cardholder Groups: Acme
Sample Basic and Acme Sample Advanced.

Cardholder Group:|Acme Sample Basic ~ J

Acme Sample Basic
Acme Samp

Acme Technologies

Lookup
Lisa Johnson
Director of Marketing
|
Report Center 1D 200000
1]}

The Basic group has six data fields and a single-layer card design. The Advanced group
has additional fields, including signature and fingerprint fields, and a multi-layered card
design. These card designs are linked to a sample database that includes four sample
records. The card designs, data and data fields may be modified.

To use a sample group to get started, click the ellipsis button to the right of the
Cardholder Group:

Cardholder Group: [ lg

This will open the Manage Cardholder Groups dialog. Highlight the group and select
Edit. Rename the group to an appropriate name and select Design Options, then select
Edit with ID Flow... to edit the design.
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Cardhalder Group Properties [

[ General | Ervcliment| Fiec
|

|
| Cascholder (a3t

| Gelect he defabase el vl coriai 1he cachoider
| -

Card Database...

Manage Cardholder Groups @ |
Card Design

Blasic
Advanced

Import Design...

Ilmﬂ

Expart Design...

in

!
Add. m Delse | l |
Cl l ok Cancel Hel |:
4 b -

ose Help

[

After design modifications are finished click Exit and Save , click OK on the Cardholder
Group Properties dialog, and click Close on the Manage Cardholder Groups dialog.

Once completed, enroll new cardholders using by clicking the Enroll button and see
records by clicking the Record Screen button. Sample records may be deleted, but it is
suggested a new record be added first so that the data set is not empty.

Modifications to the enrollment process, record look up and logs and reports are
configured and the Cardholder Group Properties dialog shown above and will be
explained in the id flow Card Issue Center section below.

Additional sample card designs are available in the ID Flow Card Designer.
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ID Flow Card Designer
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ID Flow Card Designer is used to create ID card designs. A guided setup wizard will walk
you through selecting card stock, card format, single/double-sided, connecting to a data

source, selecting text and image fields for the design, setting a background and

password protection.

To use the wizard select Create new document and Use the guided setup wizard:

Welcome

LX) New Document

(o]

Select an option below to begin.

What would pou like to do?
* Lrmole nev document
" Open existing document

" View sample document

¥ Show at staitup

Welcome to ID Flow

Cancel

Getting Started

& Use the guided setup wizard

Hest » Einish Cancel

I you are a navice uzer, you should choose the guided setup wizard which will walk you
thraugh setting up pour new document. Adwvanced users may wish to skip this step,

How would you like to create your new document?

" Skip document setup and use the default settings

<Back |i Hewt> "}

Finish

Databases

The setup wizard presents three database options:
1. Use existing database
2. Use sample database
3. Create a new MS Access database

To use an existing database: Select the database type, the location and its table, view or

join.

New Document Wizard (=5

Database Settings

Configure the database connection below.

Database Type:

A i
Location: | Browse...

Login / Password
Table Category Tables =
Source Table [Select Table] +|  Schema.

Cancel < Back I Next > Einish
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Jolly Products are open-data architecture. ID Flow has the ability to use existing data

sources as the basis for ID card design and production. The Database Settings dialog
shown above established a live connection to an existing database. Any modifications
to the schema and the data will apply instantly to the existing database.

Design Screen

The design screen contains four toolbars: general items, alignment tools, design objects
and object formatting.

€% ID Flow - [ID Cards - 1]
[] File Edit Add View Tools Window Help

( D™ » & aX| 0|88 |os I~ ShowLayers [ Live Diata ¥ Double Sided @ Show UV ]
( B e[Em o+ AT+ 1o ¢ A6 gL B N b e o)
w =l B0 -] [l = [T =] [— =] a7 ~] ]
—— I
i
q General [tems Object Formatting
l Alignment Tools
]
9 —— Design Objects
I
=]
1 rt .
= Pointer T | Insert Text
=| i Zoom E Insert Image
E L Draw Line Wl | Insert 10 Barcode
— O Draw Rectangle/Square I8l Insert 2D Barcode
| Draw Ellipse/Circle 55| Format Magnetic Stripe

Cards are designed by selecting the design object on the left-hand toolbar and by
drawing that object’s area on the card with the mouse. After the area drawn the
object’s Properties dialog will appear. Click through the tabs to format the object.
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wlayers [ Live Data ¥ Double Sided W Show LY

5 in =
] in |inches

¥

in
in

w

h

<1/ ® [+ 5 ] [— ] s o]
R

NS

|

<<FirstName>> <<Las|
<<Agency>>

&[0

Image Properties

Image | Prpenties| Border| Dimensions | Print Candition
Image Source
£ Fived image from file
€ Vatisble image from e or intemet
& Variable image fiom database
£ Image captured or selected at printtime

Datsbase Field

Select a database field that contains either the photo data or the exact
location of the image file:

[State

wiorkPhone

HomePhone

MobilzPhare L
Emailtddress

Date0iBirth

T erminationD ate

Sinwah re

Ok Eonee] j J Help

1

Objects may be resized at any time and Properties dialog re-accessed by double-click.

Working with Text

ID Flow contains rich text editing. Regular text, database text, serial number, date and
time may be combined within one text box. Type with a keyboard or use the + Field

button for text selections.

= < (- [F T o] =] [ =] [—=] w7 =]
K| = T ;
&f.: _
\5 Text ezl
D F Tewt | Propestes| Berder] Digensorc: | P Condon |
5 | B G ssy EEE -, |0 O R |
O | ==LasiName=>
T | Dept: =<Department=>
1L.3
L] fR
— E BT ki Astabins finkd s Smn e, chick,on s Fiekd
=]| —
a | Senial Number...
] ™ Do
- | O Bate. |
Time.
| Data Entered ot Print-Time... L A I ]
——
Symbal. f
= Tab i

There are three types of text formatting: Text Box, Flexible Text and Circular Text. Text
Box will always place text within the bounds of the box drawn in the design: If larger, it
will auto-reduce in font size or word wrap. Flexible Text will maintain font size
regardless of the size of the box drawn. Circular Text formats text in a circle.
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" <<FirstName>> <<LastName>>
Dept: <<Department>>

-] | a
Test

L

Tent Evcpetss | Bosdes| Dimensios | Print Concition |

Syie Teort Hew -]
T Direction Flebile Text
| Crcuds Test
3 I o wirap

¥ Auto Beduce Fort Size

Working with Layers

Like other quality graphical design tools, ID Flow uses a layered design approach. Layers
may contain different design objects of varying opacity. Using layers adds a rich depth
to design and creates highly secure cards.

To see the layers window click the Show Layers checkbox on the top menu bar. Layers
are added using the [+] button at the bottom of the window. Use the arrow buttons to
move layers above and below other layers. Click the Print checkbox on each layer to
format its print condition. The active design layer is highlighted blue.

W

N

N

o). :

T4 B " =
= ) <<First>> <<Lasts>
| - <<Title>>
wi,

€0

Viewing Designs with Live Data

At anytime the card design may be viewed with data by checking the Live Data button
on the top menu bar:
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Q|-
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o -

ol|

T| ]

E 5 Lisa Johnson

| Director of Marketing

=I %

2 1D #3330000

B _
[ TART AT A/

To view the full record set: go to File -> Database Setup or click the data icon on the top
menu bar:

B File Edit Add View Tools Window Help

DZd|o=|smrx(aleal

Working with Print Conditions

Design objects or design layers may be set to print only if specific database conditions
are met. Print conditions are set on the Print Conditions tab of the object’s properties
dialog. K Panel (Black Panel) and UV Panel are also set on this tab.

Rectangle Properties

F!oundngss! Border! Ei\ll Dimensidtes

 Alwaps print this object
L~ Do nat-pristthis-obisct

( i+ Print thig object based on
I Printin black (K] & Print Condition [Elglﬁ

T~ Printin ultravicls

(O = " GSpecify SOL Expression Clear Filter
— | Contion |vaue [End [ combine
—_— [ Department Contains Sales ] aR
W [ Department Containg tarketing ] EMD
|

| [‘Department” ke '%5ales®") OR [Department” like "%Marketing®']

Saving a File

- Page 10 -

© 2008 Jolly, Inc. All rights reserved.
http://www.jollytech.com



@V

JOLLY
Use File -> Save or Save as... to save and name the design. ID Flow files are saved with a
.jps extension. Though cards can be printed from the design screen or Database Setup,

design files are typically imported into the Card Issue Center for production.
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ID Flow Card Issue Center

The Card Issue Center is used for day-to-day data entry and production of ID cards. It
allows the user to enroll new cardholders, lookup an existing record and view reports of

all actions that have occurred. The Record Center shows all database records and their
ID card design.

i e e Gt
Record Center
Enroll ieconks 40 A Sarmpie Akanced

Lookup T T

Report Center

Go To Record Center | _-‘_‘q,_}_ =

Card designs are typically first created in ID Flow Designer and then imported into /D
Flow Card Issue Center.

Card Issue Center is designed so that multiple locations may be networked through
sharing a central file. For this reason, there are two types of configuration settings:
Global and Workstation.

The Small Business Edition does not have networking abilities; however, it also contains
Global and Workstation settings.

To Setup, select the setup button on the Main Menu screen or from the Admin Menu.
Only Administrators have setup ability

Q Main Location - ID Flow - Card Issue Center
File Help

LI Global Settings...

SEtUp Workstation Settings...

Global Settings

Global Settings are configured in the Company Setup dialog. Depending on the edition,
it may contain Cardholder Groups, Locations, Logs and Reports, Security Policy, User
Accounts and the Company Source.
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Compary Setup ==
[ Cauhaide: Gioups
Crmate a carchokder gioup o each group of people b vihom you intend to issue ID cards. Each

o irchades & cand lapoud, a databads whare casdholder information is stoned, sepditing
Logs And Rleports apdions. petmissions arvd cels ielationshios

Securiy Poicy
User Accounts

Caditmtongs | [ Puview
cme 5 anple Advanced
Aeme S anple Basic

B
=1
aad Ed. | Delte
Company Source...
Cloze Help

The Company Source is the central database file that, for networked versions, should be
placed on a secure internal server or shared workstation. For stand-alone copies it does
not need to be moved.

Settings for Locations, Logs and Reports Security Policy and User Accounts are obvious
when the dialog is open.

Cardholder Group settings work in tandem with Workstation settings. Examples: 1. In
order to capture a signature in the enrollment process, the signature field must be
defined in the cardholder group’s Enroliment tab; 2. In order to lookup a record by email
address, that field needs to be defined in Record Lookup tab; 3. In order to log the name
and titles of cardholders, those fields must be defined in the Logs and Reports tab.

To configure the cardholder group’s settings, highlight the group and select edit.

Cardholder Group Properties ==
General  Ervollment | Record Lockup | Legs and Rieports | Pecord Fiters | Authorized Users |
Stens to Pertorm During Cardhalder Erraliment

Select the steps to perform during the cardholder envcllment process. Device
specific seltings are configured on a per-workstalion basis in Workstation Sellings.

I~ Scan diver's icense, ID card ar passport

Company Setup = "
¥ Take phota Saveinfield | Phota -
= Corchaider Giope
(SFRRSTTS | i a conchker s o mach crous of pecple s wher ot s ) ccs. Each & Caplure signature Saveinield [Sigate =
1 0 goup includes a caid lapoul, a datsbase whese candholder nfomation is slored, reporting
optons. pemissions and dala relalionshio: ¥ Scan fingerprint Savein field | Fingerprint ot
{ Eordbe — | P

| [icme Semple Aidvarced
| S B

e
ad | e Dekin
Company Source... 2 =
Cloer Help Ok Cancel Help
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Workstation Settings

Workstation settings apply to the specific workstation. They include selecting the
location, cardholder groups available at this location, selecting which tasks will be
available to the user, configuring the tasks and capture devices, and selecting the

language to be used a this location. Tasks are configured individually through the task’s
blue hyperlink or together via the configure button:

Workstation Settings ==
Location

Select the location where this workstation resides.

Workstation Location
Cardholder Groups

Select the cardholder groups that can be used at this workstation

[AnDesigns =] [ Workstation Tesk Settings =

{ Main Meny | Enroliment | Record Lookup | Checkin/0ut | Reports | Equipment |

Default Task
Tasks Set the defaull task [wainters =]
Select the tasks to perform at this workstation. To configure a task
simply click on .
¥ Enroliment [¥ Main Menu Main Menu Appearance
[¥ Recard Lookup [¥_Show Record Center IV Showr design preview on main menu
i e
Language
Restart the application after changing the language selaction
English - s

[~ Show selection dialog at startup

0K Cancel J Help. J 0K

Cancel Help

Importing a Card Design

Card designs are typically first created in ID Flow Card Designer and then imported into
ID Flow Card Issue Center. To add a new card design, Go to Global Settings ->

Cardholder Groups and select “Add.” This will open the Cardholder Group Properties
dialog.

Cardholder Group Properties

Geneal | Ernalmert | Fiscord Lockup | Logs ard Reports | Record Evers | Authorized Lisers |

| Gioun Mame: [My Campany
Canchroldes Diatabase

Compuny SEup = Select the database that wil contain the caidholder ecords
oo Catbrkdet Greups [ sbase sk Card Dfsbsse..
Cardheider Goca Cieate  cartbles qrous e esch groug of peopke 1o whom you inlend 1 issus ID cards. Each
Location: uin inchudes & cand lapout, 2 o 2 dholder shored, 1porting Cand Dipsigr
Logs Ard Fieports ‘options, peimistions and data isafionships
Secusly Py
User Accounts _ . A |
Carchid Bimgs | | Peview \ e "
et Sangla Advanced Edit with ID Flow...
Seme Gangie Basc

| bmpert Design...|

Export Design..

!

ﬂ!
u

() s | oo

Close. Help

ok | Concel Hep
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Enter a Group Name then select Design Options and Import Design. Browse to the .jps

file created in Card Designer. The option will be provided to import the designs
database with the design. If so, it will automatically populate the Card Database dialog.
Next, select the fields in the Enrollment, Record Lookup and Logs and Reports tabs.

Important note on imported designs: It is a copy of the design that is imported into
Card Issue Center. Changes made to the design using Card Designer, must be re-
imported for the changes to be reflected in Card Issue Center. Changes can be made
directly to the Card Issue Center copy by selecting Edit with ID Flow... in the Cardholder
Group Properties dialog. In this instance, changes made to the imported copy are not
reflected in the original copy.

Enrollment Configuration

Users define the relevant workflow for enrollment. Available steps include Data Entry,
Photo Capture, Signature Capture, Fingerprint Capture and Card Printing:

Start Enroliment
Please complete the enrollment form below and click Next when finished Phota

Priss 1 Take Phow
0 Four photors o uss

Take Photo

Browse For Phato...

Enrollment Successful

Signature Capture Jor eneoling! Chek PriRg to prnt your badge
Plasa sign using the signatire pad

Print

Sean

3. 4, 5.

To configure photo capture, driver’s license scan, signature capture and fingerprint scan
in enrollment, first define fields in the Cardholder Group Properties (Global Settings),
and then define the process available in the workstation settings:
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Cardhalder Group Properties =
Genersl - Ervclnert | Fecord Lockup | Logs and Rlepats | Aiecord Biters | Authorized Lsers |

Steps 1o Pediom During Cardholder Envoliment

Select the steps to periom during the casdholder errolment mocess. Device
specihc seltings e conlguied on a pei-soekatalion bisks in Workatalion Selings

Scan diver's icense, 1D caud o passpart

= - | Workstation Task Settings =
W Take phato Saveinfisd [Photo |
- Enrollment
¥ Caphus sgnahae Saveinfiekdt [Sgnatan ~|
W Sean ingepeirt Seve nliekd [Frosenn =
[Country g Start Options

¥ Allow Enroliment
Information Capture

[ Scan driver's license or government ID*

[V Take visitor's photo* " Eamera Options...

[¥ Obtain electronic signature* Signature Pad Options. .

[V Sean fingerprint Fingerprint Options.
Badge Printing

¥ Automatically print badge in background Printer Options.

v Show print button en confirmation screen

* Task will only be performed if configured in cardholder group settings

T Help oK J Cancsl j Help

The capture device specifications are configured by clicking the Options buttons in the
Workstation Task Settings.

Notes about capture devices:

ID Flow supports TWAIN and WIA compatible cameras. The ability to capture a photo
from within ID Flow and trigger the flash will depend upon the camera’s software. 1D
Flow is commonly used with web cams: When Microsoft WDM is invoked as the capture
source, four photos are captured and the best may be chosen.

Capture Live Image E|
Live Preview Select Best Image
i (-, A )
e
r
(-
-~ P
= . (v )
“ideo Source. . “ideo Format... |
Start Capture.. | l
| Cancel | Help |

ID Flow supports Topaz and Interlink USB signature and fingerprint pads.

ID Flow support Card Scanning Solutions ScanShell 800, ScanShell 1000 and SnapShell
camera for driver’s license and/or passport scanning. It does NOT support the S8O0ON.

Some device files and drivers may be found under “add-on modules” on the “Download”
section of the www.jollytech.com website.
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Record Lookup Configuration

Record Lookup allows the user to quickly search for records. When multiple matches
occur a selection dialog is shown. Strict matching may be invoked.

Lookup Record

Please scan the badge or enter the ID number and click Next.

L Select From Matching Records = = ]
i e nkar el = T - |-41] & ]
# FistMane Last Hane Tile Depaitmert Date of Bith Difver's Licsrise §

C1 Lisa dohnson  Phesident Comporate:

T 2 Jame Johnson  Sheppng Mansger Dishibubion

Dan't krow the 10 number? Complete this form to fook if up
First Name
[ Last Name ITW’I"" "

lal | 1]
Date of Birth —
[1007Page =]
Carecel Help. |

Record Found

The following matching record was found.

Edit [ Print J View History ]

W Fl_ P
ames chnsan - i

Acme Technologies
[Shipping Manager i = L]}

pre——
SHpRTgManader
Lty Siat M E0; [l Code! —

L R LIN N ID #102

Edit Card Design | Show Back Side

Fm&_

102

To configure record lookup, first define the lookup fields in the Lookup Fields tab of
Cardholder Group Properties dialog found in Global Settings, then, define the options in
the Workstation Settings.

[ Cardnolder Group Properties =i

Genersl| Ervobmert | Fiecod Lockun | Logs and Reports | Flecord Eiers | Authoszed Lisess |

Uirique: Fiecoed |desiifes

tecoid mus conlan 20 Bl ndnadual seconds can
o ot S the sl atusts I thal il corl Typrcabs this
el hores the csholder [T et e i he defsbase beble's primary key

Unicus Riecord Identfie it~ [IDNumber -

Workstation Task Settings.
Fiscond Lookup Lsing Record Infomaticn E{é‘c‘u‘r‘l‘ltc‘néiﬂb.il
IF a cardholder's secoid iderdifier i unknown, the recond can be beated by enteing
candcka mlomalion Sekct carchoider val be stk
o earvide, W yona o ok wank o enable (e e, imervs ol of the fiekds blark
Information Fiskd 1: [Frethlama = Repdiooby)
E T [¥ Alow Record Lookup
Infomation Fiskd 2 [Lastame e :
Record Lookup Options
Irfoumgtion Fleld 3: _ |DainOiith | [¥ Mask ID number input (characters will be replaced with * symbol)
Indcatiation Fiskd 4 | I Use sirict matching - all information fiekds must be complete
W Alow user to select from muttiple matches
Ok _Cwcdd | Heb | 0K Cancel Help
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Report Center Configuration

Logs and Reports shows activity on all actions that occur in the product: when a record
was added, edited or deleted and when card was printed; by whom, at what time and
location. Custom logs may be designed. Reports may be printed, exported and emailed.

O Wiain Lncabian - Pl - Card i Evei

Logs and Reports

Select 3 100 of 1o bekw

Four fields from a cardholder’s record may be configured in the Logs and Reports tab on
the Cardholder Group Properties dialog. The Workstation Setting for Logs and Reports
makes the item available or not.
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Record Center

Record Center is used for the management of records. Records may be added, edited,
deleted, printed and duplicated from this screen. The down-arrow button provides
additional options.

& Main Location - ID Flow - Card Issue Center pm | e
File Admin Help

Record Center

Records for 'Acme Sample Basic' are available below. Main Menu

New ] Edit 1 Delete Fint ] jl WDMjJ:-!J EL_%&_} Jfgg—“y EEJ

Records 3

View Current Record

View All Records

Current Record L | Duplicate Record
|

Acme Technologies

Selected Records 3 | View Log...

ohinzon

I

Capture Image...

Edit Record Layout...
Director of Marketing

Edit Card Design...

Department
M arketing | Modify Database Source...

Date of Birth
37371983

100

Lisa Johnson
Director of Marketing

D #100

Edit Card Design

Records may be viewed in single-record or spreadsheet view by selecting the buttons on
the right of the toolbar.

Q Main Location - ID Flow - Card [ssue Center EI@
File Admin Help

Record Center

Records for 'Acme Sample Basic' are available below. Main Menu

Mew ] Edit 1 Delets Frint }v] =[] Tofl = ;_.] EE | Jfﬂ—_u %1—%
[T # FistMame LastMame Title Departrnent Date of Bith 1D Humber Photo
¥ 1 James Tolstaoy Shipping Manager Distribution 24141980 102
[T 2 Danil Belmaont %P Engineering Engineering 51419658 103
¥ 3 Lisa Johnson  Director of Marketing Marketing 3431983 100
¥ 4 Michelle  Smith WP Sales Sales £44/1971 101

Records may be batch printed, deleted and edited by checking the box to the left of the
record and selecting the appropriate action. Records may be sorted by clicking on
column headers.

The toolbar contains filter and sort buttons EI? . Filters are used to create data
subsets. Sorting allows for multiple field sort criteria.
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71 Filter Records E=H EoR(m>
" Show gl Records
' Apply Fiter | i
@ Apply Following Condition:
£ Build SOL Expression " Specily SAL Expression Clear Filter Sort Setup... ==l

Walue |End |Eﬂmhms|

[Begin]Fiei [ ordiion % Sart Records by Following Fiskds

DateOfBith _-j After 111380

Sott on Field [soting Order [ Combine

IDNumber Firsthl ame Ascending AND
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Configuring the Record Screen

ID Flow Enterprise and Corporate Editions have drag-and-drop record screen formatting.
Select Edit Record Layout from the down-arrow menu on the Record Screen: Size and
move fields with the mouse. Caption placement, colors and alignment tools are
provided on the menu bar.
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Advanced Field Formatting

ID Flow Enterprise Edition contains advanced field formatting. To configure a field,
double-click on the field while in Edit Record Layout. Fields may be made Visible,
Required and Read Only. They may be given default values. Drop-down lists may be
created. Text can be set to Capitalize, UPPER CASE or lower case. Image paths may be
created to store variable images to file. Fields can automatically update after a card is

printed.
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Configuring Language

ID Flow is available in 10+ languages. Select the language in the Workstation Settings. A
translation table allows the user to make changes to the translation or to translate into
a language not yet provided by Jolly. After changing languages, restart the program.

Workstation Settings

Location

Select the Iocation where this workstation resides.

==

B Translation Text

Workstation Location:

Wain Location

Cardholder Groups

Select the cardholder groups that can be used at this workstation.

=

File Find

as in the English version.

|AII Designs

Tasks

Select the tasks to perform at this workstation. To configure a task
simply click on it.

¥ Enroliment
¥ Record Lookup

¥ Main Menu
[+ Show Record Center

Configure

Restart the application after changing the language selection.

¥ Logs and Reports

=l

Enter translated text in the right-hand column. Special tags must be entered exactly
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Bestemt dato

Angi en tittel for data blokk og hvor ofte blir
brukeren bedt om en ny brikke av data
Angi en tittel for bildet og hvor ofte biir
brukeren bedt om et nytt bide under utskrift
Angi Kriterier
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The information contained in this document represents the current view of Jolly Technologies on the issues discussed as of the date
of this publication. This paper is for informational purposes only. Jolly Technologies makes no warranties, express or implied in this
document. Jolly, Jolly Technologies, ID Flow, Lobby Track, and Command Line Utility are either trademarks or registered trademarks

of Jolly, Inc. in the United States of America and/or other countries. The names of actual companies and products mentioned herein
may be the trademarks of their respective owners.
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